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I. 1. The Standalone EQuIS Data Processor 
 
The Standalone EQuIS Data Processor (EDP) is a software program used to check data prior to loading into 
the Delaware Department of Natural Resources and Environmental Control’s (DNREC's) EQuIS database. 
The purpose of the EDP is to identify incorrect valid values, missing information or data that contradicts the 
business rules of the database.  There are two desktop modes of EDP: Standalone and Professional. 
Professional EDP is linked directly to the database and can be used to check and load data into the database. 
This manual only addresses the Standalone EDP which was designed to assist data providers with checking 
their data prior to submitting it to clients or regulators to ensure high data quality as well as to streamline the 
data submittal process.  
 
EDP checks all of the following data quality issues: 
 

• Required Fields 
• Field Lengths 
• Data Types 
• Valid Dates 
• Reference Values 
• Duplicate Rows 
• Range Checking 
• Program Business Rules 

 
1.1 Getting Started 

 
Data providers first need to obtain the following: 
  

• Standalone EDP 
• DNREC Format Files 
• DNREC References Values 

 
The EDP, the DNREC format file, and the DNREC reference value file are all available for download by 
DNREC data providers on the DNREC EDP Download page: 
  

• http://www.earthsoft.com/products/edp/edp-format-for-dnrec/.   
 

Note: Directions for installing the EDP and registering the DNREC format are described in 
Appendix A of this user guide. 
 

Start EDP by selecting Programs > EarthSoft > EQuIS Data Processor from the Start Menu. The EQuIS 
Data Processor opens on the main EDP screen. 
 

http://www.earthsoft.com/products/edp/edp-format-for-dnrec/
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Figure 1 – EQuIS Data Processor 

 

1.2 Format File 
 
The Format File contains the definitions that are attributed to the DNREC EDD format for each individual 
section. The DNREC format ensures that the data provided to DNREC meets DNREC’s data quality 
standards. The DNREC EDD format file consists of the following files that reside in the same folder 
(typically the Program Files\EarthSoft\EQuIS\Formats\EarthSoft\ folder): 
 

• DNREC.dll 
• DNREC.xml 
• DNREC_RVF.rvf 
• DNREC-enum.xml 

 

 
Figure 2 – Folder with DNREC Format File and Reference Value File 

 
To open a Format File in EDP: 
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1. Click Format File  located in the upper left hand corner of EDP, and browse to the 
DNREC.xse file (\EarthSoft\EQuIS\ Formats\DNREC\ folder). 

2. Select the DNREC.xse format file and click Open. 
3. Register the format file when opening it for the first time – See Appendix A for details. 

 

 
Figure 3 – Standalone EDP with DNREC Format open  

 
When you have successfully opened the DNREC Format, your computer screen looks like Figure 3. 
 
The following are the parts of the file format : 
 

• (1) Sections of the DNREC format 
• (2) DNREC format tab 
• (3) Directory path to the DNREC format 
• (4) Version of the DNREC format 

 
Users can identify what format file and the version of the format file that has been loaded by selecting the 
Format Tab. The path to the format file is displayed in the lower left corner.  The version of the format file is 
displayed in the lower right corner.  It is recommended that all EDP users check this path and version prior 
to each use of EDP.  
 
Now that a Reference Value File and Format File have been successfully opened, EDP is ready to load and 
check a data file. 
 

Note: If you use the same Format File repeatedly, there is a preference you can set in the Options 
menu so that you always open that particular Format File when EDP starts (For more information, 
see 1.17 EDP Options in this manual). 

 

4 

1 
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1.3 Understanding the DNREC Format 
 
The DNREC format includes tools to assist users in understanding the format’s requirements. These tools 
include tool tips, color-coded column headers, and drop-down boxes that enforce reference values.  
 
To view the DNREC Format, click on the second tab in the lower left corner of the main EDP Screen (See 
above Figure 3 – Standalone EDP with DNREC Format Open). 
 
In the DNREC Format, tool tips are displayed in the column headers (See Figure 4 – EDP Tooltip 
Example). To access these tool tips, hold your mouse over the column headers’ name. Use these tool tips to 
help you determine what values to use when populating each field, as well as to determine which reference 
value table is used to populate the field.  Data providers may also refer to the EDD Description for this same 
information (See Section 1.15 – Exporting EDD Description for more information).  
 

 
Figure 4 – EDP Tooltip Example 

 
Another aid to help you understand the format, is the color-coding that is used to indicate what each column 
represents. The defaults are: 
 

• (Underlined) Red – Column headers that are underlined and use red font (default color) are required 
primary key fields. The primary key fields are required and must be unique.  

• Red – Column headers with red font (default color) are required fields. 
• Blue – Column headers with a blue font (default color), are reference value fields. 
 

Note: Required fields may also be reference value fields; when this occurs, the column header is 
displayed in a red font. 

 
You can modify the default font colors in the Options Tool in EDP (See 1.17 EDP Options in this manual). 
 
Finally, the DNREC format provides you with drop-down lists that appear when you place your cursor over 
any Reference Value or Enumeration Value field. These drop-down lists display the approved reference 
values from the applicable reference table or values from the enumeration file. If an error indicating a 
“Reference value not found” or “Value not found in list” is displayed, you can select one of the values 
from the drop-down lists to resolve the error. 
 
Figure 5 shows an example of a drop-down list in EDP. In this example, the selected sample matrix is soil – 
which is indicated by the code “SO”.   
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Figure 5 – EDP Drop-Down List Example 

 
1.4 Reference Value File 

 
The Reference Value File (RVF) specifies what reference values, or valid values, are allowed in the data 
file. This file is a lookup list that displays the values that you can choose from for a particular field. 
 

Note: This file is extremely important for data management and the communication of data across 
many organizations.   

 
To review the Reference Values directly in EDP, click on the first tab in the lower left corner of the main 
EDP Screen. 
 
You do not have to manually open the reference value file to ensure that you load the appropriate set of 
reference values for each format. Instead, each time you open the DNREC format file, or any other format 
file, EDP goes to the same folder as the format file and looks for a file with the extension “.RVF “ (the 
reference value file). If a file is present, that file is opened and used. If there is no *.RVF file, then you are 
prompted to browse to the appropriate *.RVF file. 
 
When EDP loads the format file, the Reference Values tab, located in the lower left corner of EDP, shows 
the various tables and valid values defined within each table. 
 

Note: Values displayed on this tab are not editable, and if values need to be added, data submitters 
need to notify DNREC and request that a new .rvf file be created. 

 
If you need to add a new reference value to the database/reference value file, please send an email to 
DNREC_EQuIS@delaware.gov with the following information: 
 

1. Your name and company name 
2. Reference value you want to add 
3. Name of reference table the value belongs in (i.e. rt_analyte) 
4. Brief description of the reference value (i.e. for analytic methods) 
5. Reason to ‘Why’ the value is needed 
6. Error Log as attachment (optional) 
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Once DNREC approves the reference value and adds it to their database, an updated DNREC.rvf will be 
made available to data providers via email or the DNREC Download Page. When the datasets are checked 
using this updated file, the errors associated with this reference value will be eliminated.   
 
To facilitate finding the appropriate reference value, click the column headers to sort the Reference Values. 
 

 
Figure 6 – Reference Value File 

 

• (1) Reference tables 
• (2) Reference values tab 
• (3) Directory path to reference value file 

 
1.5 Data Files 

 
The data file, also known as an Electronic Data Deliverable (EDD), contains the data that needs to be 
checked in EDP. The data file can be an individual Tab delimited (.txt) or Comma Separated (.csv) file. 
Alternatively, you can also load an Excel workbook (.xls), Access database (.mdb), or Zip (.zip) file 
containing several .txt or .csv files. To use these alternate data file formats (.xls, .mdb, .zip, etc.) with EDP, 
you must include the EDD format name in the data file name. Including the format name allows the data file 

1 

2 

3 

https://earthsoft.com/products/edp/edp-format-for-dnrec/
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to be checked against the correct format. Additional naming convention details are provided in the sections 
that follow.   
 

1.6 Loading Individual CSV or TXT Data Files 
 

You can load data files into the EDP by selecting the EDD button  from the main EDP toolbar and 
browsing to the EDD file you want to load into EDP. When multiple sections exist within a given Format 
File, and you are loading individual data files in the .csv or .txt formats, the data file selected is loaded into 
the currently selected section. 
 
For example, in the DNREC Format tab, the section DataProvider_v4 is the first section listed. This section 
is highlighted by default upon opening the format. Any data file opened without changing the format 
section selection will be loaded into this section, even if this data should be loaded into a different section. 
 
To load a data file: 
 

1. Select the section of the format, for example Sample_v4. 

2. Click EDD  from the EDP Toolbar. 
3. Browse to the folder where data resides and select the appropriate file. 
4. Click Open. 

 
The data check occurs in the background while the data file is being loaded. When using EDP, EarthSoft 
recommends loading data into the DNREC format’s sections in the order listed to ensure that all data checks 
are completed properly. The sections are listed in parent-child order, such that if the last section is loaded 
before the first, errors may appear which require you to refresh the data to enable EDP to relate the sections. 
 

1.7 Loading Excel, Access, or ZIP Data Files 
 

You can also load Excel, Access, and Zipped data files into EDP by selecting the EDD button  from 
the main EDP toolbar and browsing to the EDD file you would like to load into EDP.  Unlike .csv or .txt 
files, when loading Excel, Access, and Zipped data files, the section of the format currently selected is not 
relevant. Instead, EDP uses the name of the individual Excel worksheet, Access table, or file included in the 
zip file, to open the file into the appropriate section(s) of the format.  This functionality allows users to open 
data into more than one section of an EDD at one time, thus streamlining the data checking process.   
 
The following sections outline the specifications that you need to follow when loading data from an Excel, 
Access, or ZIP file. 
 

1.7.1 Excel Files 
 
When using Excel files with EDP, the Excel file (.xls or .xlsx) can use any nomenclature, however you must 
name the worksheets according to the EDD section names. For example, the Excel spreadsheet shown in 
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Figure 7 – Excel Spreadsheet, contains data in the DNREC format.  Figure 7 shows how the worksheet 
names must correspond to the section names of the DNREC format.  In this example, the first worksheet tab 
is named DataProvider_v4 to match the first section of the DNREC format.  Note the additional worksheets 
are also named for their respective EDD sections (Subfacility_v4, Location_v4, etc.).  
 
The Blank EDD Template is a very useful tool built into EDP for creating EDDs using Excel Workbook 
templates. (See Section 1.14 – Exporting Blank EDD Template for more information).   
 

 
Figure 7 – Excel Spreadsheet 
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1.7.2 Access Database Files 
 
Similar to Excel files, you can use Access database files (.mdb or .accdb) to load data into EDP. The 
individual Access database file can use any nomenclature, but you must name the data tables according to 
the EDD format name. For example, the Access database shown in Figure 8 – Access Database contains 
tables, which use the DNREC Chemistry section’s names as the table names.    
 

 
Figure 8 – Access Database 

 

1.7.3 ZIP Data Files 
 
When using Zipped data files with EDP, you must name the individual .csv/.txt files, Excel worksheets, or 
Access tables within the *.zip file with the appropriate corresponding section name of the DNREC EDD 
format.  For example, the zipped file shown in Figure 9 – Loading Zip Files contains data files which use the 
DNREC Chemistry section’s names as the text file names.  Within a Zipped file, it is also acceptable to 
include Excel files or Access database files as specified in Sections 1.7.1 and 1.7.2 above. 
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Figure 9 – Loading Zip Files 

 
1.7.4 Load and Append Multiple Data Files 
 

When you load data files, it is also possible to load multiple data files of the same format during the same 
“EDP session” (as shown in Figure 10 – Load and Append Data File). For example, if after loading the 
Sample data you receive another Sample_v4 data file, which should be included with the current data set, 
you can use the Load and Append Data File utility to simultaneously check both files in EDP. 
 

Note: This functionality is only enabled once a data file is loaded. 
 
To load and append data: 
 

1. Right-click on a section name to bring up a list that includes the Load and Append Data File 
utility.   

2. Browse to the data folder and select the next data file to load.   
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Figure 10 – Load and Append Data File 

 
Using the Load and Append utility appends the new data file to the end of the original data file. 
 

1.8 Clearing Tables 
 

If you accidentally load a data file to the wrong section, you can clear all data rows by right clicking on the 
format name and selecting Clear Table or clicking Clear from the Data section of the EDP toolbar and 
selecting Clear EDD. 
 

1.9 Finding Errors 
 
Once you load an EDD into EDP, you can identify which section(s) contain at least one error because the 
sections’ name listed on the left side of the screen will be highlighted in red. 
 

Note: In Figure 11 – Displaying Errors, the section TestResultQC_v4 is red. 
 
Also, any data that do not satisfy the checking requirements identified in the Format File are highlighted in 
the data grid. Finally, the line numbers along the left side of the data grid are red in lines where an error 
exists. 
 
To obtain additional details about what each error means, hold your cursor over the highlighted cell in the 
data grid.  
 

Note: You can change the colors assigned to each error. For additional information on changing these 
color codes, see 1.17 EDP Options section in this manual.  
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Figure 11 – Displaying Errors 

To view only the records with errors, check Errors Only  from the View section of the 
EDP toolbar.  
 

 
Figure 12 – Displaying Errors Only 

 
1.10 Error Log Reports 

 
You can view a summary report of all errors in the data files by reviewing the Error Log or Error Summary 
Reports. 
 
The Error Log Report is a report that can be created to show what line in each section of the format 
contains exactly what error. The Error Log Report maintains EDP’s error color coding to make error 
resolution easier. 
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The Error Summary Report may also be created to show a summary of all of the errors in the data files. 
Each row of the Error Summary Report contains the number of rows where the specified error occurred in 
each section of the format. The Summary Report does not maintain the color coding. 
 
The Error Log and Error Summary Reports are saved as HTML files by default and open automatically in 
your default browser, but the reports may also be saved as XML, Excel, or Text files. 
 

Note: The EDD Format File name and Version information are also reported in Error Logs. In 
addition, information related to the EDD Data Files, User Name, and Reference Values File that 
were used during the error checking process are also listed in both of these logs to facilitate error 
resolution. 

 
To view the Error Log: 
 

1. Select the Error Log option from the Error Log Group.   
2. Enter a file name and click Save. 

 
To view the Error Summary: 
 

1. Select Summary from the Error Log Group. 
2. Enter a file name and click Save. 

 

 
Figure 13 – EDP Error Summary Report 

 
1.11 Saving Modifications 

 
Before you begin, it is important to understand that edits made to data files within EDP are not automatically 
saved. If you are modifying data files using the edit feature available in EDP, then you should save your data 
files frequently during an EDP Session. 
 

Note: It is important to keep your original file and file name. Using the “Save As” feature, save your 
modified file with another file name. 

 
To save modifications made to data in EDP: 
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1. Select the File tab located in the upper left corner of EDP. 
2. Select Save As> EDD. 
3. Browser will pop-up. Re-name the EDD. 
4. Select Save. 

 
1.12 Error Resolution  

 
As discussed in section 1.9 Finding Errors, errors that are found in EDP are highlighted with a specified 
color to signify the type of error. You can correct these data errors within EDP if the Edit feature was 
enabled during installation of EDP. 
 

• To make modifications to any cell within the data file after it is loaded, highlight the cell and type 
the modification. 

• To correct Reference Value errors, use the drop-down lists associated with the field where the error 
occurred. 

 
Note: See 1.4 Reference Value File in this manual for additional information. 
 

1.12.1 Column Headers 
 
The top one or two rows of an EDD typically contain column header information, useful to ensure that the 
correct data populates each column, and to check that the appropriate data file was loaded into the correct 
section of the format.  
 
You can instruct EDP to ignore any header rows in the data grid. 
 
To ignore header rows:  
 

1. Highlight the header row(s)  
2. Select Set as Comment Row.  

 

 
Figure 14 - Set as Comment Row 

 
The text in the row(s) becomes italicized and includes a dollar sign ($) directly before the first letter of the 
column header. 
 

Note: Typically, the comment indicator is a pound sign (#), however, DNREC’s format uniquely 
uses the dollar sign ($) as the comment indicator instead. 

 
You can skip the step of setting a row as a column header if the data file’s comment row(s) include this 
dollar sign ($) prior to being loaded into EDP.  
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Figure 15 - Example of Dollar Sign ($) Comment Indicator 

 
You can choose to not view the Comment Row(s) using the option on the View group.  

Note: Find the check next to the word "Comment Rows". If you click the Comment Row option, 
the check is removed and the Comment Row(s) will not be displayed. To view the comment row(s) 
again, toggle the switch. 
 

1.12.2 Reporting Reference Value Errors and Error Logs 
 
As outlined in the Reference values section of this manual (1.4 Reference Value File), using consistent 
nomenclature is extremely important for data management. Therefore, reference value and enumeration files 
are part of DNREC’s format file to make resolving reference value errors as easy as possible. New reference 
values may need to be added to the database.  
 

Note: These new reference values will need to be reported to the DNREC data management team via 
email to DNREC_Equis@delaware.gov.   

 
Using Standalone EDP, you can easily provide a summary list of missing reference values for the database 
manager to resolve. This can be useful for data providers to do when requesting that new reference values be 
added to the .RVF file, enabling them to successfully submit data. Once all data issues are resolved, other 
than the new reference values, you can create an error summary log outlining the new reference values.  
 
Providing the error log to the database management team displays a summary of any missing reference 
values that may need to be added to the database.  
 

1.13 Tools 
 
There are several options available in EDP toolbar to assist with data review.   
 

 
 

Figure 16 – Filter, Pin, Find, and Sort Tools 

Use Sort  to sort the data in ascending or descending order. For example, if you want to sort the result 
data based on chemical name, you can highlight the chemical name column and click Sort. 

Filter Pin Find Sort 

mailto:DNREC_Equis@delaware.gov
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Use Filter  to narrow the data set for viewing subsets of the data. Click Filter, and each column is 
enabled with a pull-down menu, which allows you to filter on the available values for that field. Do this by 
clicking on the filter icon, then chose the selection you wish to use.  Click the Filter again and select All to 
remove the filter. You can also select Custom to build your own selection criteria. 
 

 
Figure 17 – Using the Filter Tool 

Use Pin  to assist with viewing large data sets. Click Pin and a “pin” is enabled adjacent to each field. 
When selected, the pin holds that column in place while viewing the related fields for each record.  As you 
scroll to the right, the “pinned” column remains stationary so you can review the data associated with each 
sample. 
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Figure 18 – Using the Pin Tool 

 
Use Find button to find or replace multiple fields with new data. To use this, select any field within the column 
you would like to search. Then select the Find button and the Find and Replace window opens. This will 
allow you to enter the text to be found (and the text to replace the original text with if desired). 

Note: Recent selections are available for reuse under the drop-down arrow(s). 
 
The Find and Replace tool can be focused on a selection of the available rows in a displayed data file by 
selecting these rows prior to the opening the Find and Replace option and choosing “Selection” from the drop-
down menu in the “Within:” option. 
 
Additional choices are “Table” for the entire data file screen displayed, and “All” for all EDD tables open. 

 
• Search by provides options to search by rows or columns. 

 
Other options include “Match Case” and “Match entire cell contents”, which should be used when an exact 
match is desired. These options also eliminate the inclusion of partial matches, which could create new errors. 
For example, when changing a Method from E300.0 to E310.1, selecting Match entire cell contents will 
prevent the modification of a Batch ID or Lab QC Sample ID that may also include the text "E300.1". With 
this setting, only the method cells containing E300.1 as the sole content will be selected. 
 

• Show Matches will open a detail box that will list the matches found. 
• Replace will replace the items one at a time. 
• Replace All will replace all items found. 

 
Note: Be careful using the Replace feature.  If you do not correctly set your search to “Selection” or 
“Table” or fail to choose “Match Case” or “Match entire cell contents” you may replace data that you 
do not intend to. 
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Figure 19 – Using the Find and Replace Tool 

 
1.14 Exporting Blank EDD Template 

 
Built into EDP is a tool for creating EDDs using Excel Workbook templates.  Data providers may add data to 
this blank EDD. To use this tool: 
 

• From the Tools group select Blank EDD 
• Excel will open and an EDD template will be created. The template includes the column header color 

coding and tool tips. 
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Figure 20 – Blank EDD Template (DNREC Format) 

 
1.15 Exporting EDD Description 

 
The EDD Description option allows users to export detailed description of a format. This detail includes data 
types, key fields, required fields, field description and the database mapping. 
 
To review the descriptions in Excel, select EDD Description from the Tools group. Excel will open and the 
descriptions will be displayed. If the format contains multiple sections, such as the DNREC format, 
worksheets will be created for each section. 
 

 
Figure 21 – EDD Description (DNREC Format) 
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1.16 Submitting an EDD 

 
After using the tools outlined above to resolve all of the errors in a set of Data Files, the data is ready to be 
submitted to DNREC for loading into the EQuIS database. This “EDD Package” should be submitted to 
DNREC via email at DNREC_Equis@delaware.gov. 
 
Things to note with each submittal: 
 

• cc: the DNREC Project Officer 
• The subject line of the email should include the facility name, facility code (i.e. DE #), and whether 

it is an original submittal or a corrected submittal. 
 
At this time, the “Sign and Submit” feature of EDP should not be used by DNREC data providers. 
 

1.17 EDP Options 
 
You can modify the following: 
 

• The default functionality of EDP so that EDP will not recall the last Format File used. 
• Use a different comment indicator code. 
• Increase the number of errors that EDP checks for when Data Files are initially loaded into EDP.  
• Change the EDP Application Appearance. 

 
1.17.1 Remember Last Format File 

 
By default, EDP was designed to always recall the last format file the application used. If you do not plan to 
use the same Format File repeatedly, there is a preference you can set in the Options menu, so the last 
Format File used is not always opened when EDP starts. 
 
To set the Remember Last Format File option: 
 

1. Select the File menu, then click Options on the bottom left. 
2. On the Options dialog, click General. 

 
The option RecallLastUsedFormatFile has a default setting of Yes. This indicates that the last 
format file used in EDP will be opened during the following EDP session. 

 
You can change the setting to No to have EDP open to a blank screen each time EDP is launched.  

 
Note: If RecallLastUsedFormatFile is set to Yes and the specified Format File is not available or 
cannot be found, a warning message is displayed, and you have the opportunity to select a different 
Format File 

 

mailto:DNREC_Equis@delaware.gov
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Figure 22 – Option to recall last format opened in EDP. 

 
1.17.2 DNREC Default Comment Indicator Code & Error Threshold 

 
The default comment row indicator in EDP is a pound sign (#). 
 

Note: DNREC’s Format uses the dollar sign symbol “$” as the comment indicator by default. Users 
do not need to change any EDP settings for this to work. Please make sure that any EDDs submitted 
to DNREC use the “$” as the comment indicator. 
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DNREC’s Electronic Data Processor (EDP) 

QuickStart Guide for Data Providers 
 
 
 
 
 
 



This document provides a quick overview on how to download, install, and use the EQuIS Data Processor 
(EDP) software to check and submit the Department of Natural Resources & Environmental Control (DNREC) 
Electronic Data Deliverables (EDDs). (Prepared for version 4 EDD format) 
 
For a more detailed discussion of the functionality and technical specifications of EDP, Data Providers are 
strongly encouraged to review the instructions and information available on the DNREC EQuIS Data 
Submittal Website: https://dnrec.alpha.delaware.gov/waste-hazardous/equis/ 
 
EDP Download Procedure 
 

1. From the DNREC EQuIS Data Submission web page, click on the “EQuIS Documents and 
Reference Files" on the right of “Step 2”. 

 

 
Note: This will take you to the DNREC EDP Format Files Download Page. 

 
2. Click on the appropriate link for the “32 bit (x86)” or “64 bit (x64)” under “EQuIS Data Processor 

(EDP) v7.x” to download a version of the EQuIS Data Processor (EDP) software (where x is the 
latest version of the EDP application that DNREC distributes on this page). 

3. Click on the “Delaware DNREC EDP Format” link to download the latest DNREC EDD Format 
files.  

 
 
 

https://dnrec.alpha.delaware.gov/waste-hazardous/equis/
http://www.dnrec.delaware.gov/dwhs/SIRB/Pages/SIRB_EQuIS.aspx
https://earthsoft.com/products/edp/edp-format-for-dnrec/
https://earthsoft.com/products/edp/edp-format-for-dnrec/
https://earthsoft.com/products/edp/edp-format-for-dnrec/
https://earthsoft.com/products/edp/edp-format-for-dnrec/
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Note: When downloading these files, you must save them to a folder in which you have read-write 
privileges.  This will be the folder from which EDP locates the format file.  Make a note of the folder 
so that you can navigate to the format when you open EDP. 

 
The EDP file is the user interface (software program) that must be used to check and prepare the DNREC 
EQuIS EDD for submittal. The DNREC Format file contains the information that the EDP program uses to 
check the completeness and accuracy of the DNREC EQuIS EDD being submitted. Please make sure you are 
using the most up-to-date version of the DNREC format. 
 
Unblock the Downloaded Zip Files 
 
When downloading files from the Internet or other location, Windows may set an attribute on the file to 
Blocked. When this happens, it may not load properly into the application. For example, if you download a 
non-standard EQuIS format, it may be blocked. When attempting to use that format in EDP, it may not show 
up in the list. This behavior is the default for .NET 4.x, which is used in EDP and is designed to help protect 
the computer from executing malicious files. Whenever downloading a file, the recommendation is to check 
for the blocked attribute and then “Unblock” the file so it will load properly.  
 
Tip: When you download a file, save it to a known folder where you have update permissions – e.g. the 
"Downloads" folder. 
 
To unblock the EDP and DNREC Format Files: 
 

1. Right click each file and select properties from the content sensitive menu. 
2. On the “General” tab, click the “Unblock” check box, click Apply, and click “OK” to save these 

changes. 
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Unblocking Files 

 
3. Now you can extract the contents of the EDP_7.x_x64 or _x86 file to run the 

EarthSoft_EDP_Standalone_7.x_x64.exe file to begin the installation of EDP. 
 

Installing the Files 
 

1. Open the directory where the EDP file was downloaded and right click and select “Extract All.” 
2. After the contents of the EDP zip file have been extracted, navigate to the location of the files and 

double click on the EarthSoft_EDP_Standalone_7.x_x64.exe file to begin the installation. 
3. Follow the installation wizard prompts to complete the EDP software installation. 

 
Periodically, EDP and Format files will be updated and posted to the DNREC EDD Submission Website. 
Updated files will be posted when DNREC updates the format of the EQuIS EDD or revises the valid values 
tables.  Data Providers will be notified via e-mail from DNREC_Equis@delaware.gov.  

Note: Data Providers are encouraged to check for the most recent file version prior to preparing 
EDD submittals to the DNREC. 
 
 To update the EDP program, download the most recent version from the DNREC EDP 

Format Webpage. Prior to installing the updated program, you must uninstall the current 
version. Once the previous version is uninstalled then the new version can be installed 
following the step-by-step instructions above. 

 

mailto:DNREC_Equis@delaware.gov
https://earthsoft.com/products/edp/edp-format-for-dnrec/
https://earthsoft.com/products/edp/edp-format-for-dnrec/
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 To update the DNREC Format File, download the most recent version from the EarthSoft's 
DNREC EDP Format Webpage.  Each new copy of the format zip file will need to be 
unblocked. Right click on the zip package, select Properties, and "unblock" the files. You 
may then extract the files to the folder. 

 
Registering the EQuIS Data Processor 
 
After the EDP program has been installed, you must register the software with a free registration key: 
 

1. Double-check the EDP icon on your desktop to open the program. 

2. Click on the “Format” button , which is the first button in the EDP ribbon menu on the top 
left and looks like a checklist. 

3. Browse to the location on your hard drive where you unblocked and extracted the DNREC EDD 
format files and open the DNREC.xse file. 

4. The first time you install EDP and open the DNREC.xse EDD format files, you will be prompted to 
register the software.  This register screen can also be accessed by clicking on the “notepad with 
green checkmark” icon in the upper left corner and selecting “Register” from the drop-down menu. 
 

 
Registering EDP 

 
5. The Software Registration dialogue box will open (See screenshot above). At the bottom of this 

window, click the link to “request registration key for this computer” and follow the online 
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instructions providing the necessary information (Step 6 below). A registration key will be emailed 
to you, usually within an hour. Once you receive the e-mail, open it and copy (Control+C) the code, 
and then paste (Control+V) it into the “New Key Codes” box in the Software Registration window 
(Step 7 below).  To get back to the window, simply follow the instructions for Step 4 described 
above.  After you paste your registration key code into the box, click the “Save Key(s)” button to 
complete your registration. Then click “OK” to close the registration window. 

 

 
 

EDP Registration Form 
 

6. Complete the Registration Form and click “Submit”. 
7. Once you receive the e-mail with a registration code, copy & paste that code back into the EDP 

Software Registration window under the “New Key Codes” box and click “Save Key(s)”. 
Make sure there are no blank spaces in the key you paste into the window. 
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Key Code Window 

 
After the EDP software is installed and registered, the DNREC Format File can be opened: 
 

1. Start the EDP program (it may already be open if you just completed registration). 

2. Select the “checklist” icon labeled Format  in the upper left corner. 
3. Select the DNREC.xse file. 

 
Note: If you did not save the Format Files to a default location when downloading, you may have to 
browse to their location on your computer. 
 

4. Click Open. 

 
DNREC EDD Format 
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The DNREC EDD Format has six groups of EDD sections. These EDD groups all appear in the left panel 
within EDP (visible on the previous page) and are: 
 

• Initial 
• Subsurface Investigation 
• Field Activities 
• Chemistry 
• Basic Historical 
• Vapor Intrusion 

 
More information about each EDD section, in each grouping, is detailed in the DNREC EDD Manual and 
the EDD Description file, which can be accessed by clicking on the Excel icon for an EDD Description file 
button. 
 
Loading your EDD 
 
To load an Excel or Access EDD file containing multiple data sections: 
 

Note: It is recommended that you close the Office application – Excel – prior to opening your EDD 
in EDP.  (The excel formula functions can do strange things to your data if the application is 
still open.) 

1. Click the EDD button  from the Open menu. 
2. Browse to the file, and select “Open”. 

 
EDP will load all the tables of the EDD file into the appropriate EDD sections. To load a text EDD file 
(preferred method): 
 

1. Select the format section the text file corresponds to (for example, if a location_v5.txt file is to be 
checked, the location_v5 format is selected). 

2. Click the EDD button  from the Open menu. 
3. Browse to the EDD file and select “Open”. 
4. EDP will load the file into the selected format. 

 
Correcting Errors in the EDD 
 
After the file has been loaded, any errors will be identified with various colors. Additional details on why a 
record is in error are available by hovering the cursor over the error in question. You can also download an 
“Error Summary” containing a summary of all unique errors or an “Error Log” containing a detailed list of 
the first 500 errors on each row in the EDD file. 
 

https://earthsoft.com/products/edp/edp-format-for-dnrec/
https://earthsoft.com/products/edp/edp-format-for-dnrec/
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Error Log Tab of EDP 

 
Note: If the Access or Excel EDD contains header rows, EDP will identify fields in the header rows as 
errors unless the first entry in each header row is preceded by a dollar-sign character ($). The “$” sign 
identifies the row as a comment row.  If you have a header row, which you would like to set as a 
comment row, right click on the button to the left of the row and select “Set as Comment Row”.   
Alternatively, you may also delete the header row after it is imported to the EDP program. 
 

 
Data tab in EDP 

 
 

• To view only records with errors, check the box next to 
“Errors Only” located in the top menu bar.  

• To see all the records, uncheck the “Errors Only” box. 
• You can also clear the data from EDP by selecting the 

“Clear” button in “Data” section of the menu. 
Choose to “Clear Table” to clear the current table or 
“Clear All” to clear all tables and re- open the data from a 
source EDD file. 

 
• For reoccurring errors with similar values that need to be changed, the “Find and Replace” button, 

also in the Data section of the menu allows users to search a portion of the EDD file for specified 
values and replace them with another value. Predicate 
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Find and Replace 

 
• If an error is related to a DNREC Valid Value list, a drop-down list will be available to select the 

appropriate value. 
 

• If a valid value is not present, Data Providers should follow the procedure in the EDD manual or 
DNREC EDP User Guide for requesting valid values. 

 
• Once the error is corrected, the cursor is moved off the cell, the color highlights should be removed 

indicating a correct value has been entered. You may need to refresh the table using the Refresh 

button , also in the “Data” section of the menu bar, to have the error highlight cleared. 
 
• Once the record is error free, highlights indicating errors will disappear from view.  Errors will 

appear in Red until they are resolve.  Once all errors are resolved in a tab, the tab color will change 
to Green.  The goal is for all tabs with populated data should be Green, error-free. 

 
Re-load the remaining tables that make up your EDD and repeat the procedures above until no errors are 
identified in any of the tables. For example, a typical analytical data EDD submittal would include at a 
minimum: 
 

• DataProvider 
• Location 
• Sample 
• TestResultQC 
• Batch 

 
Note: You can always save and re-open your EDD as you work in EDP making changes to correct 
errors. 
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It is always best to first start correcting errors in the sections of the “Initial” EDD grouping first at the top of 
the list moving down to the lower tables on the list.  Relationships exist between many of the sections within 
the EDD and editing or deleting records in one table may result in “orphan records” in the lower tables. Once 
you have corrected the EDD data file, save it by checking the upper left corner icon and select “Save”. 

 
Saving in EDP 

 
If you need further assistance after reviewing this Quick Start Guide, please refer to the Delaware DNREC 
EDP Format page for the following file: 
 

• The full DNREC EDD Submittal Requirements Manual (PDF). 
•  

 
For additional questions related to the DNREC EDD format and submittal process please direct all 
inquiries to DNREC_EQuIS@delaware.gov. 
 
For technical issues with installing EDP and getting the latest DNREC EDD format installed and 
registered, please contact the EarthSoft Support Team at support@earthsoft.com. 

https://earthsoft.com/products/edp/edp-format-for-dnrec/
https://earthsoft.com/products/edp/edp-format-for-dnrec/
mailto:DNREC_EQuIS@delaware.gov
mailto:support@earthsoft.com
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